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Adressaten dieses Papiers

e Anwender von Software, die zur Bereitstellung eines
Datentragers nach GDPdU aufgefordert werden.

e Entwickler von Software, die steuerrelevante Daten flr die
Datentrageriberlassung nach GDPdU bereitstellen.

Zusammenfassung/Ziel

Nach §147 Abs.6 AO ist es der Finanzverwaltung moéglich, die Daten
von elektronischen Buchflihrungssystemen ,digital® zu prifen,
entweder durch Datentrageriberlassung und/oder durch mittelbaren
bzw. unmittelbaren Zugriff.

Fir die Datentrageriberlassung ist es notwendig, dass die Daten vom
steuerpflichtigen Unternehmen (oder dem beauftragten Steuerberater,
buchfliihrenden (Sub-)Unternehmen, etc.) in ,maschinell auswertbarer
Form"™ auf geeigneten Datentragern bereitgestellt werden.

Unter dem Begriff ,maschineller Auswertbarkeit"® versteht die
Finanzverwaltung den wahlfreien Zugriff auf alle gespeicherten Daten
einschlieBlich der Stammdaten und Verknidpfungen mit Sortier- und
Filterfunktionen.

Um eine solche Auswertbarkeit oder Verwertbarkeit zu erreichen, ist es
notwendig, dass die Dateiformate flr die Datentragertberlassung
definiert und standardisiert werden.

In diesem Dokument wird ein Verfahren vorgestellt, das die definierte
und standardisierte Datentrageriberlassung ermdglicht und einen
Standard flr die Softwareindustrie beschreibt.

Bei Ruckfragen wenden Sie sich bitte an mailto:GDPdU@audicon.net,
oder informieren Sie sich unter http://www.audicon.net.
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Text des §147 Abs. 6 AO

[In der Fassung des Gesetzes zur Senkung der Steuersatze und zur Reform der
Unternehmensbesteuerung (Steuersenkungsgesetz - StSenkG) vom 23.10.2000
BGBI. I 2000. S. 1433]

(6) Sind die Unterlagen nach Absatz 1 mit Hilfe eines Datenverarbeitungssystems
erstellt worden, hat die Finanzbehdrde im Rahmen einer AuBenprifung das Recht,
Einsicht in die gespeicherten Daten zu nehmen und das Datenverarbeitungssystem
zur Prifung dieser Unterlagen zu nutzen. Sie kann im Rahmen einer AuBenprifung
auch verlangen, dass die Daten nach ihren Vorgaben maschinell ausgewertet oder ihr
die gespeicherten Unterlagen und Aufzeichnungen auf einem maschinell
verwertbaren Datentrager zur Verfligung gestellt werden. Die Kosten tragt der
Steuerpflichtige.

Datentrageriiberlassung

ein moégliches Szenario fir eine Steuerpriifung mit
Datentrédgeriberlassung:

Ein Steuerprifer bekommt den Auftrag, ein Unternehmen zu prufen.
Fir bestimmte Prifungsfelder und Prifungszeitraume beschlieBt der
Steuerprifer, die Daten unter Zuhilfenahme von Prufungssoftware zu
analysieren. Entsprechend wird dem Unternehmen die Prifung
angekindigt und die Prifungsschwerpunkte bekanntgegeben. Er bittet
das Unternehmen, die steuerlich relevanten Daten auf einem
maschinell auswertbarem Datentréager nach den Vorgaben der
,Grundsatze zum Datenzugriff und zur Prifbarkeit digitaler
Unterlagen™ (BMF Schreiben vom 16.07.2001) bereitzustellen.

Bei Prufungsbeginn erhalt der Steuerprifer eine CD-ROM als
Datentrager.
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GemaB seinem Prifungsschwerpunkt sucht der Prifer die
entsprechenden Tabellen heraus und liest diese ein. Auf der CD-ROM
sind steuerrelevante Daten und beschreibende Daten enthalten, um
die Daten ohne weitere Erklarungen einzulesen. Sobald die Daten in
die Analysesoftware importiert sind, flhrt der Steuerprifer eine oder
mehrere Analysen (teilweise durch Makros automatisiert) aus.

1. Fordert Daten-CD-ROM an
Liest Daten-CD-ROM ein

FGhrt Analyse aus bzw.
lasst Analyse-Makros
ablaufen

Priferin
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Aus Sicht des Unternehmens fallen bei dem oben beschriebenen
Szenario folgende Arbeitsschritte an:

Ein Mitarbeiter initiiert die Datenextraktion bzw. Export aus der
Produktionsdatenbank, wobei die Daten ggf. (automatisch)
transformiert werden in dem Sinne, dass die Datenorganisation, die
Struktur der Tabellen oder Objekte geandert wird.

Ebenso muss bei komprimierten oder verschlisselten Daten die
Komprimierung bzw. die Verschlisselung aufgehoben werden. Zu den
steuerrelevanten Daten muss nun noch eine Beschreibung in Form
einer maschinenauswertbaren Datei erzeugt oder hinzukopiert werden.
Eine solche Datei muss in dem Fall bei der Bereitstellung erzeugt
werden, falls der Softwarehersteller nicht vorhersehen kann, welche
Daten bei der Prufung bereitgestellt werden sollen. Es kann eine
statische Datei bereitgestellt werden, falls im Voraus der Umfang und
die Struktur der Daten feststeht.

Die Daten werden anschlieBend automatisch oder manuell auf einem
beweglichen Datentrager (CD-ROM, DVD,...) gespeichert.

Produktivsystem
e ¥
i ';E“[“mr :
Extraktion
m SAP Transformation
m Datev Bereitstellung
m Baan
m Navision J'
® Oracle Financials Organisation
u \{arial Datenformate Prufer/in
= andere Komprimierung
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Die Datenorganisation bei der
Datentrageriiberlassung

Das BMF-Schreiben vom 16.07.2001 gibt den gepriften Unternehmen
bei der technischen Organisation des zu Uberlassenden Datentragers
grundsatzlich einen breiten Spielraum.

Nachdem die Finanzverwaltung des Bundes und der Lander eine in der
Wirtschaftsprifung verbreitete Analysesoftware (IDEA 2002) beschafft
hat, sind die Steuerprifer in der Lage, Daten maschinell zu lesen und
(automatisiert oder manuell gesteuert) zu verarbeiten. Die
Finanzverwaltung definiert die Datenfelder und Inhalte, die bei der
Datentrageriberlassung auf den Datentrdger gebracht werden, nicht.
Entsprechend ist es notwendig, dass Steuerpflichtige und/oder
Hersteller von Software, die steuerlich relevanten Daten verarbeiten,
selbst entscheiden, welche Daten bei der Datentrageriberlassung
bereitgestellt werden. Dabei kdnnen je nach EDV-System, Software-
Strukturen, Unternehmensstruktur und -GréBe unterschiedliche
Dateninhalte sinnvoll und notwendig sein.

Um Ruckfragen durch den Steuerprifer Uber die Dateninhalte und
Formate zu minimieren oder unndétig zu machen, wird hier ein
Verfahren beschrieben, das die Daten, Datenstrukturen und
VerknUpfungen beschreibt und kommentiert.

Um die unterschiedlichen Datenstrukturen verarbeiten zu kdnnen,
stellt der Steuerpflichtige oder sein Berater die steuerrelevanten Daten
weitgehend denormalisiert zur Verfligung. Zusatzlich liefert er eine
maschinenauswertbare Beschreibung der Daten, Datenformate, und
Verknupfungen. Das Dateiformat flir die steuerlich relevanten Daten
wurde auf gangige Standardformate festgelegt. Beides,
steuerrelevante Daten und Beschreibungsdaten, werden auf einem
gemeinsamen Datentrager bereitgestellt.
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Steuer-
relevante

Daten RNEUEGIEIREL
FixedLength

=
=

Beschreibungsdatei:

Datenbeschreibung XM L

und -verknupfung

Datentrager

_F (CD-ROM, DVD, etc.)

Die unterstlitzten Dateiformate fiir die steuerlich relevanten Daten
sind:

e VariableLength
e FixedLength

Damit ist es den Softwaresystemen moglich, bereits bestehende
Exportfilter oder Speicherungsmechanismen zu nutzen.

Die Finanzverwaltung erlaubt keine Installation von Spezialsoftware
zur Entschlisselung oder zum Dekomprimieren von Daten auf ihren
Systemen. Insbesondere beim Postversand von Datentragern ist
jedoch zumindest das Verschllsseln von Daten aus
Datenschutzgrinden erforderlich. Im Beschreibungsstandard st
deshalb vorgesehen, z.B. Programme zur Entschllsselung oder zum
Dekomprimieren direkt vom Datentrager zu starten ohne dass sich
diese auf dem System der Finanzverwaltung installieren.

Die Computer der Prufer sind mit Zugriffsschutz-Software und ggf.
Anti-Viren-Software ausgestattet. Die Funktionsfahigkeit dieser direkt
aufgerufenen Programme sollte deshalb vom Daten-Bereitsteller im
Vorfeld geklart werden. Die Prifung auf Lauffahigkeit dieser Routinen
ist nicht Gegenstand des Beschreibungsstandard.
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Die Rolle des Softwareherstellers

Im Folgenden wird als ,Softwarehersteller™ - aus Sicht des
steuerpflichtigen Unternehmens - ein externer Lieferant von Software
oder einer Datenverarbeitungsanlage inklusive Programmen oder eine
interne Abteilung, die entsprechende Programme bzw. Services
bereitstellt, angenommen.

GemalB den dargestellten Szenarien zur Betriebsprifung muss bei der
Betriebspriufung u.a. eine maschinenauswertbare Beschreibung der
Daten und der Verknlpfungen bereitgestellt werden.

Die Beschreibungsdatei wird von einem Programm gelesen, das gemaf
dieser Beschreibung die Import-Funktion des Analyseprogramms des
Steuerprufers steuert. Es werden keine Operationen auf Datenbanken
der Produktivsysteme ausgeflhrt.

Der Hersteller der Programme bzw. Prozeduren, mit denen das
steuerpflichtige Unternehmen steuerrelevante Daten verarbeitet
(Softwarehersteller), muss zusatzlich zu einer Extraktionsfunktionalitat
die Aufbereitung oder Bereitstellung der Beschreibungsfunktionalitat
sicherstellen.
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XML-basierter Beschreibungsstandard

Uberblick

XML ist die ,eXtensible Markup Language". XML gibt nur einen
generischen Satz von Sprachelementen vor, so dass je nach
Anwendungsfall eine eigene Sprache definiert werden muss. Die
jeweils neu formulierte Sprache kann durch Strukturinformationen und
Elementdefinitionen in einer DTD (Document Type Definition)
maschinenlesbar hinterlegt werden. Damit kann ein XML-Parser
uberprifen, ob ein XML-Dokument der vereinbarten Sprache entspricht
(validieren). Man unterscheidet also zwischen Sprachbeschreibung in
der DTD und den Inhalten in der XML-Instanz.

In der DTD selbst werden also keine Beschreibungsdaten fir die
Datentrageriberlassung gespeichert, sondern in der XML Datei
INDEX.XML. Die DTD beschreibt den Aufbau der INDEX.XML Datei.

Weiterfihrende Informationen zu XML findet man auf www.w3c.org.

Allgemeine Annahmen bzw. Voraussetzungen zur DTD

Es wird in der DTD davon ausgegangen, dass die steuerrelevanten
Daten in Dateien organisiert sind. Pro Tabelle wird genau eine Datei
angenommen, so dass die Organisation nach Datei und Tabelle
physisch zusammenfallen.

Die Beschreibungsdaten fur die Datentragerlberlassung werden in
einer Datei INDEX.XML gespeichert.

Die DTD muss sich in demselben Verzeichnis auf dem Datentrager
befinden wie die INDEX.XML Datei.

Werden mehrere Datentrager (Medien) bereitgestellt, muss sich die
INDEX.XML nur auf dem ersten Datentrager befinden.
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Technischer Ablauf des Importprozesses

Der Importprozess wird von einer Komponente gesteuert, die die
INDEX.XML Datei interpretiert und die Exporttabellen von den
einzelnen Datentragern an die Analyse-Software Ubergibt. Diese
Komponente Uberprift die INDEX.XML Datei auf Korrektheit und dient
dem Prifer als Inhaltsverzeichnis fur die gelieferten Daten.

steuert
GDPdU
Interpreter

Analyse-
software
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<?xml version="1.0" encoding="UTF-8"?>

<l--Versions available:

1.1 (August-01-2002)

>

<l-- Start Simple Types -->

<l-- Supplementary Vocabulary -->

<IELEMENT Version (#PCDATA)>

<IELEMENT Location (#PCDATA)>

<I[ELEMENT Comment (#PCDATA)>

<IELEMENT Length (#PCDATA)>

<IELEMENT References (#PCDATA)>

<I[ELEMENT From (#PCDATA)>

<IELEMENT To (#PCDATA)>

<l-- Specifying a maximum length for a VariableLength column can

reduce a VariableLength tables' import time. If MaxLength

is not specified then we parse URL to determine the MaxLength
for each column.

* Only applies to VariableLength tables. -->
<I[ELEMENT MaxLength (#PCDATA)>
<l-- Specifies which character (if any) encapsulates a
VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "

* Only applies to VariableLength tables. (Optional) -->
<IELEMENT TextEncapsulator (#PCDATA)>

<l-- Specifies how many  digits appear to the right of the decimal symbol.

CAUTION: Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0' (Optional)
-—>
<IELEMENT Accuracy (#PCDATA)>
<l-- The decimal place is not always stored with numbers. If each number
is supposed to have decimal places use ImpliedAccuracy -->
<IELEMENT ImpliedAccuracy (#PCDATA)>
<l-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->
<IELEMENT Format (#PCDATA)>
<l-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. '’
Specified once per Table. -->
<IELEMENT DecimalSymbol (#PCDATA)>
<l-- Specifies the symbol that groups the digits in large numbers.
Dot is the default DigitGroupingSymbol or ThousandsSeperator. "'
Specified once per Table -->
<IELEMENT DigitGroupingSymbol (#PCDATA)>
<l-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>

<IELEMENT Command (#PCDATA)>
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<l-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ../Accounts.dat
-—>
<I[ELEMENT URL (#PCDATA)>
<l-- Textual description of specified element (Optional) -->
<IELEMENT Description (#PCDATA)>
<l-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<IELEMENT Name (#PCDATA)>
<l-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<IELEMENT Epoch (#PCDATA)>
<l-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. "'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<IELEMENT ColumnDelimiter (#PCDATA)>
<I[ELEMENT RecordDelimiter (#PCDATA)>
<l-- The number of bytes skipped before reading of URL commences.
Zero is the default when not specified. '0'
-—->
<IELEMENT SkipNumBytes (#PCDATA)>
<l-- End Simple Types -->
<l-- Start Complex Types -->
<l-- Self-explanatory -->
<IELEMENT Range (From, (To | Length)?)>
<IELEMENT FixedRange (From, (To | Length))>
<l-- The document element -->
<IELEMENT DataSet (Version, DataSupplier?, Command*, Media+, Command*)>
<l-- Supported datatypes (mandatory) -->
<IELEMENT AlphaNumeric EMPTY>
<I[ELEMENT Date (Format?)>
<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
<l-- Supported codepages:
Be careful to explicitly define RecordDelimiter when using
a non-default codepage.

ANSI is the default codepage when not specified -->
<IELEMENT ANSI EMPTY>
<IELEMENT Macintosh EMPTY>
<IELEMENT OEM EMPTY>
<IELEMENT UTF16 EMPTY>
<IELEMENT UTF7 EMPTY>
<IELEMENT UTF8 EMPTY>
<!-- Supported file formats:

FixedLength

VariableLength -->

<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*)>
<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
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<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?, TextEncapsulator?, ((VariablePrimaryKey+,
VariableColumn*) | (VariableColumn+)), ForeignKey*)>
<IELEMENT VariableColumn (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<l-- Description of the entity supplying the data. (Optional) -->
<I[ELEMENT DataSupplier (Name, Location, Comment)>
<l-- The first Media will contain index.xml. Importing will process each media listed -->
<I[ELEMENT Media (Name, Command*, Table+, Command*)>
<l-- Elements common to FixedLength & VariableLength are propagated to Table. -->
<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh | OEM | UTF16 | UTF7 | UTF8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength))>
<l-- ForeignKeys denote joins or relationships between tables.
To successfully join two tables make sure both the PrimaryKey

and the referenced column (foreignkey) are of the same datatype.

Results are undefined when joining two tables with different

key datatypes. Most likely an error will occur. -->
<IELEMENT ForeignKey (Name+, References)>
<l-- Maps AlphaNumeric columns from 'From' to 'To'

ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric  -> AlphaNumeric

Date -> AlphaNumeric

AplhaNumeric -> Date

AlphaNumeric -> Numeric
-—->
<IELEMENT Map (Description?, From, To)>
<l-- Documentation for table validity. -->
<I[ELEMENT Validity (Range, Format?)>
<l-- End Complex Types -->
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Organisation des Beschreibungsstandards

«l XL
= version 1.0
_| ' = encoding UTF-5
DOCTYPE DataSet
:| 10 SYSTEM "gopou-01-05-2002 ot
« DataSet
{}Version 1.0
4 DataSupplier
{} Hame Glaswerk AG
{} Location SingeniDeutschland
_ {} Comment Datertraegeriberlassung nach GOPU vom 14 August 2002, Dr. Grassle, Tel 07544 934266
Media (2]
{3 Hame {} Table
1 D Mummer 1 | > Table
> Table
2 CD Mummer 2 | = Table
¥ Table
> Table
4+ Table
{}URL hestellungen.cay
{} Hame Biestellungen
{} Description Bestellungen-Bewegungadaten
| WariableLength
4 YariableColumn (5

13

{}Hame {} AlphaHumeric {} Date {} Humeric
1 |Artikel-Mr
2 Hunden-Code
3 Bestelldatum Date
{} Format Y MMDD
4 Lieferdatum Date
{} Format MDD
5 Bestelldatum Date

{} Format v vMMDD
_ 6 Frachtkosten
e Copament weitere columns...
ForeignKey (2]
{}Hame  {}References
1 Hunden-Code Kunden
4 1| _| 2 Artikel-D Artikel

]

.2

Das Basiselement des Beschreibungsstandards ist das DataSet-
Element. Hier enthalten sind die Elemente Version, DataSupplier,
Command, und Media.

e \Version enthadlt die Versionsnummer der Datentrager-
bereitstellung.

e DataSupplier enthalt Angaben Uber die Herkunft der Daten.

e Die Media-Container enthalten die Angaben (Uber die
bereitgestellten Datentréager und Tabellen, die darauf gespeichert
sind. Hierbei wird flr jedes bereitgestellte Datentragermedium
(CD-ROM) ein eigener Media-Eintrag vorgenommen. Somit ist es
madglich, auch mehrere Datentrager (CD-ROMs) in einem
DataSet zusammenzufassen.
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RecordDelimiter

ImpliedAccuracy

E]

Accuracy

,FixedPrimaryKey ==

1.

e

i

FixedLength [}
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Hinweise zu XML

» Hinweis zu den in XML ublichen Operatoren:

Operator Elementtyp darf auftreten
? 0-mal oder 1-mal

* 0-mal oder beliebig oft

+ 1-mal oder beliebig oft

> #PCDATA steht fur parsed character Data und bedeutet, dass
das Element flr einen Texteintrag vorgesehen ist.

» Bei Aufzahlungen werden die méglichen Werte durch senkrechte
Striche (,,|") getrennt.

» In XML muss auf GroB- und Kleinschreibung geachtet werden.

> Bitte verwenden Sie in den Beschreibungsfeldern und/oder den
Tabellen- und Spaltennamen keine der Zeichen

|n&<> ‘

Verwenden Sie stattdessen Namen oder Nummer aus der
untenstehenden Liste.

Zeichen Name Nummer
" &quot; &#34;
& &amp; &#38;
< &lt; &#60;
> &gt; &#62;
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Beschreibung der Elemente
Es folgt eine Beschreibung der einzelnen ELEMENT-Deklarationen.

Im Allgemeinen gilt, dass die in den jeweiligen Attributen ,description®
hinterlegten Texte dem Prifer als Kommentar angezeigt werden. Die
Lange des Textes in den description-Attributen sollte 255 Zeichen nicht
Uberschreiten.

<!ELEMENT Version (#PCDATA)>

Enthalt die Versionsnummer der Datentragerbereitstellung. Dieses
Element hat keine technische Auswirkung, sondern dient zur
Beschreibung.

Verwendet in Container
DataSet

<!IELEMENT Location (#PCDATA)>
Beschreibt den Standort des Datenlieferanten.

Verwendet in Container
DataSupplier

<!ELEMENT Comment (#PCDATA)>
Kommentarfeld flr zusatzliche Informationen zum Datenlieferanten.

Verwendet in Container
DataSupplier

<!ELEMENT Length (#PCDATA)>
enthalt Informationen Uber die Lange von Attributen oder Datensatzen

Verwendet in Container
Range
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<!ELEMENT References (#PCDATA)>
enthalt Informationen Uber Verknipfungen

Verwendet in Container
ForeignKey referenzierte Tabelle

Siehe hierzu auch das Beispiel auf Seite 39.

<!ELEMENT From (#PCDATA)>
enthalt Informationen Uber den Startwert eines Wertebereichs.

Verwendet in Container | Kontext-abhangige Beschreibung
Range Startwert in einem Wertebereich

Map Redefinition von Daten

<!ELEMENT To (#PCDATA)>
enthalt Informationen tUber den Endwert eines Wertebereichs.

Verwendet in Container | Kontext-abhangige Beschreibung
Range Endwert in einem Wertebereich

Map Redefinition von Daten

<IELEMENT MaxLength (#PCDATA)>

enthalt Informationen Uber die maximale Lange eines
alphanumerischen Feldes in einer VariableLength Tabelle.

Verwendet in Container | Kontext-abhangige Beschreibung
VariableColumn Maximale Lange des Feldes

VariablePrimaryKey Maximale Lange des Feldes

Die Angabe von MaxLength bei dem Dateityp VariableLength
beschleunigt den Importprozess, da andernfalls die Datei vor dem
Importprozess geprift wird und die maximalen Langen der Felder
ermittelt wird.
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<!IELEMENT TextEncapsulator (#¥PCDATA)>

Bei VariableLength-Dateien kann man Textfelder durch ein
~Encapsulator*-Zeichen einschlieBen, z.B. fir den Fall, dass der
Feldtrenner in den Daten vorkommt.

| Vorgabewert: B

Verwendet in Container
VariableLength

<IELEMENT Accuracy (#PCDATA)>

Anzahl der Nachkommastellen. Vorsicht bei Daten, deren Genauigkeit
grosser ist, als in Accuracy angegeben.

| Vorgabewert: 0

Verwendet in Container
Numeric

<IELEMENT ImpliedAccuracy (#PCDATA)>

Anzahl der Nachkommastellen, auch wenn in den Quelldaten keine
Nachkommastellen angegeben sind.

Beispiel:

Quelldaten: ,,100; 200; 102; 5000;6587890"

ImpliedAccuracy 3: ,0,100; 0,200; 0,102; 5,000; 6587,890"

Verwendet in Container
Numeric
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<!ELEMENT Format (#PCDATA)>
Angabe Uber Formatdefinitionen.

| Vorgabewert: | DD.MM.YYYY

Verwendet in Container | Kontext-abhangige Beschreibung

Date Hier wird die Maskierung fur die
Darstellung von Datumsangaben
hinterlegt.

Folgende Angaben fir Format sind
gultig:

o DD fur Tag,

o MM flr Monat,

o YY bzw. YYYY fur Jahr.

e Beispiel (30. September 2001)

MM/DD/YY: 09/30/01
DD.MM.YY: 30.09.01
MM/DD/YYYY: 09/30/2001
YYYY-MM-DD: 2001-09-30
DDMMYY: 300901
DDMMYYYY: 30092001

O O O O O O

Validity Maskierung flir das verwendete
Datumsformat (siehe Date)

<!ELEMENT DecimalSymbol (#PCDATA)>
Angabe Uber das Dezimalstellen-Trennzeichen

| Vorgabewert: |,

Verwendet in Container
Table
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<!ELEMENT DigitGroupingSymbol (#PCDATA)>
Definiert das Tausender-Trennzeichen.

| Vorgabewert: |.

Verwendet in Container
Table

<!ELEMENT Command (#PCDATA)>

Command definiert ein Betriebssystemkommando.

Diese kénnen an folgenden Stellen ausgeflihrt werden:
vor dem gesamten Importprozess

nach dem gesamten Importprozess

bevor ein einzelner Datentrager importiert wird
nachdem ein einzelner Datentrager importiert wurde

Verwendet in Container | Kontext-abhangige Beschreibung
DataSet Command fur den gesamten Vorgang
Media Command fiur einen einzelnen
Datentrager

Siehe hierzu auch das Beispiel auf Seite 41.
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<!ELEMENT URL (#PCDATA)>

Dieses Element enthdlt den physischen Dateinamen der bereit-
gestellten Datei.

In dieser Version des Beschreibungsstandards werden ausschliesslich
relative URLs unterstltzt. Als Basisverzeichnis gilt der Pfad zur
INDEX.XML.

Beispiele flir unglltige Eintrage:
http://www.somewhere.com/data/Accounts.csv
ftp://ftp.somewhere.com/data/Accounts.csv

Beispiel fur glltige Eintrage:
Accounts.dat
data/Accounts.dat
data/january/Accounts.dat
../Accounts.dat

Verwendet in Container
Table

<!ELEMENT Description (#PCDATA)>
Beschreibungsfeld..

Verwendet in Container | Kontext-abhangige Beschreibung

FixedColumn Beschreibungsfeld flr Spalten in
FixedLength-Dateien

FixedPrimaryKey Beschreibungsfeld flr Schlissel in
FixedLength-Dateien

VariableColumn Beschreibungsfeld flr Spalten in
VariableLength-Dateien

VariablePrimaryKey Beschreibungsfeld flir Schlissel in
VariableLength-Dateien

Table Beschreibungsfeld flir Tabellen

Map Beschreibungsfeld fur Redefinition von
Daten
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<IELEMENT Name (#PCDATA)>
Beschreibungsfeld.

| Vorgabewert: | Angabe aus dem URL Element

Verwendet in Container | Kontext-abhangige Beschreibung

FixedColumn Spaltenname in FixedLength-Dateien

FixedPrimaryKey Schlisselname in FixedLength-Dateien

VariableColumn Spaltenname in VariableLength-
Dateien

VariablePrimaryKey Schlisselname in VariableLength-
Dateien

DataSupplier Name des Datenlieferanten
(Firmenname,...)

Media Datentrager-Name

URL Physischer Tabellenname

ForeignKey Name des Fremdschliissels

<!ELEMENT Epoch (#PCDATA)>

Fir Daten, die eine 2-ziffrige Jahresangabe haben, kann ein
Standardplatzhalter definiert werden, der 19xx von 20xx trennt. Dieser
Wert ist mit 30 vorbelegt.

In einigen Dateien kénnte das Datum 25. November 55 entweder 1955
als auch 2055 bedeuten. Mit Epoch wird eingestellt, bis zu welchem
zweistelligen Wert das Jahr als im nachsten Jahrhundert liegend
interpretiert werden soll. Steht beispielsweise im Feld Jahrhundert-
Trennwert der Wert 50, so werden alle Jahresangaben von 0 bis 49
als die Jahre 2000 bis 2049, die Jahresangaben 50 bis 99 als 1950 bis
1999 interpretiert.

| Vorgabewert: | 30

Verwendet in Container
Table
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<!IELEMENT ColumnDelimiter(#PCDATA)>
Definiert Trennzeichen fir Datenfelder.

| Vorgabewert:

| &#59; (Semikolon ,;"

Verwendet in Container

Kontext-abhangige Beschreibung

VariableLength

Datenfeld-Trennzeichen

Beispiel fur Gbliche Trennzeichen:

Trennzeichen XML-Notation
Komma ,," &#44;
Semikolon ,;" &#59;

Tab &#9;

<IELEMENT RecordDelimiter (#PCDATA)>
Definiert Trennzeichen fir Datensatze.

| Vorgabewert:

[&#13;8#10; (CRLF) |

Verwendet in Container

Kontext-abhdngige Beschreibung

FixedLength

Datensatz-Trennzeichen

VariableLength

Datensatz-Trennzeichen

Beispiel fur Ubliche Trennzeichen:

Trennzeichen XML-Notation
CR Carriage Return &#13;
CRLF &#13;&#10;
LF Linefeed &#10;
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<IELEMENT SkipNumBytes (#PCDATA)>

Falls eine Datei am Beginn unerwlinschte Daten enthalt wie z.B. Datei-
Header, ist hier anzugeben, wie viele Bytes Ubersprungen und nicht
gelesen werden sollen.

| Vorgabewert: [0

Verwendet in Container | Kontext-abhangige Beschreibung
Table

<!ELEMENT Range (From, (To | Length)?)>

Definiert einen Bereich oder einen Startwert.
Startwert bedeutet: wird kein To oder Length angegeben, definiert
dieser Range nur einen Startwert (z.B. eine Datensatzposition).

Verwendet in Container | Kontext-abhangige Beschreibung
Table Startdatensatz

Validity Gultigkeitsbereich

<!ELEMENT FixedRange (From, (To | Length))>

Definiert einen Bereich mit Angabe von From und To oder From und
Length.

Verwendet in Container | Kontext-abhangige Beschreibung

FixedColumn Feldposition in FixedLength-Dateien

FixedPrimaryKey SchllUsselposition in FixedLength-
Dateien

<IELEMENT DataSet (Version, DataSupplier?, Command¥*,
Media+, Command¥*)>

Das Element DataSet ist das oberste Element (document-Element) in
der Hierarchie des XML-Dokumentes. Das Element DataSet ist Trager
der Version, Datenherkunft, Vorlauf- und Nachlauf-Prozesse und der
Medien, die die Tabellen enthalten.
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<IELEMENT AlphaNumeric EMPTY>
Definiert den Datentyp als alphanumerisch.

Kontext-abhangige Beschreibung
Typ des Feldes in FixedLength-Datei
Typ des Schlissels in FixedLength-

Verwendet in Container

FixedColumn
FixedPrimaryKey

Datei

VariableColumn Typ des Feldes in VariableLength-
Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

<!ELEMENT Date (Format?)>
Definiert den Datentyp als Datum.

Kontext-abhangige Beschreibung

Typ des Feldes in FixedLength-Datei
Typ des Schlissels in FixedLength-

Verwendet in Container

FixedColumn
FixedPrimaryKey

Datei

VariableColumn Typ des Feldes in VariableLength-
Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

<!IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
Definiert den Datentyp als numerisch.

Verwendet in Container

Kontext-abhangige Beschreibung

FixedColumn

Typ des Feldes in FixedLength-Datei

FixedPrimaryKey

Typ des Schlissels in FixedLength-
Datei

VariableColumn

Typ des Feldes in VariableLength-
Dateien

VariablePrimaryKey

Typ des Schlissels in VariableLength-
Dateien
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<!ELEMENT ANSI EMPTY>
Legt die Verwendung der Codepage ANSI fest.

<!ELEMENT Macintosh EMPTY>
Legt die Verwendung der Codepage Macintosh fest.

<!ELEMENT OEM EMPTY>
Legt die Verwendung der Codepage IBM-PC-ASCII fest.

<!ELEMENT UTF16 EMPTY>
Legt die Verwendung der Codepage UTF16 fest.

<!ELEMENT UTF7 EMPTY>
Legt die Verwendung der Codepage UTF7 fest.

<!ELEMENT UTF8 EMPTY>
Legt die Verwendung der Codepage UTFS8 fest.

| Vorgabewert: | ANSI

Plattform | Zeichensatz

Zeilentrenner ist LF (Line Feed), das Zeichen 10.

Unix 7-Bit-ASCII-Zeichensatz (7-Bit-ISO Code, US-Variante), nur
Rechner Zeichen mit ASCII-Code kleiner 128, also Buchstaben, Ziffern
und Sonderzeichen (Punkt, Komma etc.) ohne nationale
Sonderzeichen (Umlaute etc.) und ohne Graphikzeichen.

und 10 (Carriage Return, Line Feed).

PC unter 8-Bit-Zeichensatz "IBM-PC-ASCII", der in den unteren 127
DOS Zeichen dem 7-Bit-ASCII entspricht und ab Zeichen 128
nationale Sonderzeichen und (Semi-) Graphikzeichen enthalt.
Zeilentrenner ist die Folge CR und LF, das sind die Zeichen 12

auch einen 16-Bit-Code, den Unicode benutzen.)

PC unter 8-Bit-ANSI-Zeichensatz, der bis 127 ASCII entspricht und
Windows oberhalb 127 nationale Sonderzeichen enthalt, die nicht mit
denen des IBM-PC-ASCII Ubereinstimmen. Zeilentrenner ist wie
unter DOS die Folge CR, LF. (Spezielle Anwendungen kdénnen

Macintosh | 127 ASCII entspricht und oberhalb 127 nationale
Sonderzeichen enthalt. Zeilentrenner ist CR.

Apple Macintosh spezifischer 8-Bit-Zeichensatz "Mac-ASCII", der bis

Die Wahl der Codepage setzt keine Vorgabe flir den RecordDelimiter.
Sie missen den RecordDelimiter immer explizit angeben, wenn der

Vorgabewert (CRLF) nicht geeignet ist.

Datei: Beschreibungsstandard-GDPdU-01-08-2002
© 2002 Audicon GmbH. Alle Rechte vorbehalten

Seite 30



© audicon

<!ELEMENT FixedLength ((Length | RecordDelimiter)?,
((FixedPrimaryKey+, FixedColumn¥*) | (FixedColumn+)),
ForeignKey*)>

Definiert eine Datei vom Typ FixedLength.

Verwendet in Container
Table

<!ELEMENT FixedColumn (Name, Description?, (Numeric |
AlphaNumeric | Date), Map*, FixedRange)>
Definiert eine Spalte (=Column) in einer Datei vom Typ FixedLength.

Verwendet in Container
FixedLength

<!ELEMENT FixedPrimaryKey (Name, Description?,
(Numeric | AlphaNumeric | Date), Map*, Range)>
Definiert ein Schlisselfeld (=Key) in einer Datei vom Typ FixedLength.

Verwendet in Container
FixedLength

Siehe hierzu auch das Beispiel auf Seite 39.

<IELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((variablePrimaryKey+, VariableColumn¥*) |
(VariableColumn+))?, ForeignKey*)>

Definiert eine Datei vom Typ VariableLength.

Verwendet in Container
Table

Die Felder (VariableColumn, VariablePrimaryKey) mussen in der
Reihenfolge definiert werden, in der sie in der Datei geliefert werden.
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<!ELEMENT VariableColumn (Name, Description?,
(Numeric | AlphaNumeric, MaxLength ? | Date), Map*)>

Definiert eine Spalte (=Column) in einer Datei vom Typ
VariableLength.

Verwendet in Container
VariableLength

Die Felder (VariableColumn, VariablePrimaryKey) muissen in der
Reihenfolge definiert werden, in der sie in der Datei geliefert werden.

<IELEMENT VariablePrimaryKey (Name, Description?,
(Numeric | AlphaNumeric, MaxLength ? | Date), Map*)>

Definiert ein Schlusselfeld (=Key) in einer Datei vom Typ
VariableLength.

Verwendet in Container
VariableLength

Die Felder (VariableColumn, VariablePrimaryKey) muissen in der
Reihenfolge definiert werden, in der sie in der Datei geliefert werden.

Zu Verknupfungen siehe auch das Beispiel auf Seite 39.

<!IELEMENT DataSupplier (Name, Location, Comment)>
Enthalt Angaben zum Datenlieferanten.

Verwendet in Container
DataSet Lieferant (Firma,...)
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<!ELEMENT Media (Name, Command¥*, Table+,
Command¥*)>

Definiert den Inhalt eines Datentragers.

Verwendet in Container
DataSet Datentrageriberlassung

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTF16 | UTF7 | UTFS8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, (VariableLength | FixedLength)?)>

Definiert eine Tabelle.

Verwendet in Container
Media Tabelle

<!ELEMENT ForeignKey (Name+, References)>
Definiert eine Spalte als Fremdschlissel.

Die Spalte, auf die mit Name Bezug genommen wird, muss in der
gleichen Table als FixedColumn oder VariableColumn definiert sein.

Verwendet in Container | Kontext-abhangige Beschreibung

FixedLength Feld in FixedLength-Datei,
referenzierte Tabelle
VariableLength Feld in FixedLength-Datei,

referenzierte Tabelle

Siehe hierzu auch das Beispiel auf Seite 39.
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<!ELEMENT Map (Description?, From, To)>
Mit dem Element MAP konnen Redefinitionen auf Datenebene

vorgenommen werden.

Beispiel:

From SAusgangsdatenZ To SZieIdatenZ

1 wahr

0 falsch

Hr Herr

Fr Frau

01 Verheiratet

02 Ledig

03 Steuerklasse 3

Verwendet in Container

Kontext-abhangige Beschreibung

FixedColumn

Feld in FixedLength-Datei

FixedPrimaryKey

Schllssel in FixedLength-Datei

VariableColumn

Feld in VariableLength-Dateien

VariablePrimaryKey

Schllssel in VariableLength-Dateien

Map darf nur flr alphanumerische Felder benutzt werden.

Sie sollten vermeiden, in der Datentrageriberlassung kodierte Felder
zu liefern, sondern alle Codes in die textuelle Beschreibung
umwandeln. Wenn diese Umwandlung nicht bereits von dem
Exportprogramm vorgenommen wird, ist Map eine Mdglichkeit, Codes
Uber die Datenbeschreibung umzuwandeln.

<!ELEMENT Validity (Range, Format?)>
Definiert den Gultigkeitszeitraum der Daten.

Verwendet in Container

Table

Gultigkeitszeitraum
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Beispiel 1 fiir eine INDEX.XML

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.0</Version>
<DataSupplier>
<Name>Glaswerk AG</Name>
<Location>Singen/Deutschland</Location>
<Comment>Datentraegertberlassung nach GDPdU vom 14.August 2002, Dr. Grassle, Tel: 07544
934266</Comment>
</DataSupplier>
<Media>
<Name>CD Nummer 1</Name>
<Table>
<URL>Account.csv</URL>
<Name>Account</Name>
<Description>Accounts Receivables</Description>
<l-- Diese Tabelle gilt von 1.Januar 2000- 31.Dezember 2002 -->
<Validity>
<Range>
<From>20000101</From>
<T0>20021231</To>
</Range>
<Format>YYYYMMDD</Format>
</Validity>
<l-- Spezifiziert den Dezimaltrenner -->
<DecimalSymbol>.</DecimalSymbol>
<l-- Spezifiziert den Tausender-Separator -->
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariableLength>
<l-- ein zusammengesetzter Primaerschliissel -->
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariablePrimaryKey>
<Name>Ild</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Account Description</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Balance</Name>
<Numeric/>
</VariableColumn>
<VariableColumn>
<Name>Old Balance</Name>
<Numeric/>
</VariableColumn>
</VariableLength>
</Table>
<Table>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
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<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>
</Media>
<Media>
<Name>CD Nummer 2</Name>
<Table>
<URL>Sales.csv</URL>
<Range>
<From>56</From>
</Range>
<FixedLength>
<FixedPrimaryKey>
<Name>Salesld</Name>
<AlphaNumeric/>
<FixedRange>
<!l-- Position des Feldes: -->
<From>1</From>
<To>10</To>
</FixedRange>
</FixedPrimaryKey>
<FixedColumn>
<Name>Regionld</Name>
<AlphaNumeric/>
<FixedRange>
<From>11</From>
<Length>10</Length>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>Ild</Name>
<AlphaNumeric/>
<FixedRange>
<From>21</From>
<To>30</To>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>SalesComplete</Name>
<AlphaNumeric/>
<I-- Redefinition des Wertes "1" nach "True" und "0" nach "False" -->
<Map>
<From>1</From>
<To>True</To>
</Map>
<Map>
<From>0</From>
<To>False</To>
</Map>
<FixedRange>
<From>31</From>
<T0>32</To>
</FixedRange>
</FixedColumn>
<l-- ein zusammengesetzter Fremdschluessel der den Primaerschluessel in Tabelle Account
referenziert -->
<ForeignKey>
<Name>Regionld</Name>
<Name>Ild</Name>
<References>Account</References>
</ForeignKey>
</FixedLength>
</Table>
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<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<l-- weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<l-- weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>
<Description>Bestellungen-Bewegungsdaten</Description>
<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
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<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>

</Date>

</VariableColumn>

<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>

</VariableColumn>

<l-- weitere columns... -->

<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>

</ForeignKey>

<ForeignKey>
<Name>Artikel-ID</Name>
<References>Artikel</References>

</ForeignKey>

</VariableLength>
</Table>
</Media>
</DataSet>
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Beispiel 2 fiir Verkniipfungen

In der Datentrageruberlassung kann es sinnvoll sein, Bewegungsdaten
und Stammdaten nicht in einer breiten Tabelle zu liefern, sondern in

getrennten Tabellen abzuspeichern:

Beispiel:
r_, -
.
w Artikel-hr
Firma artikelname
Kontaktperson Ligferanten-tr
Fosition rm Kategarie-Hr
Stralfie Liefereinheit
Crt * Einzelprei
. ; preis

Region Artikel-Nr Lagerbestand
FLZ Kunden-Code BestellkeEinheiten
Land B_estelldatum Mindestbestand
Telefon Liferdatum auslaufartikel
Telefax Frachtkosten

Empfanger

Strafie

Ot
Bestimmungsland
Einzelpreis
Anzahl

Rabatt

In den Stammdaten werden die Primarschlissel beschrieben:

<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktpersion</Name>
<AlphaNumeric/>
</VariableColumn>
<l-- weitere columns... -->
</VariableLength>
</Table>

<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<!l-- weitere columns... -->
</VariableLength>
</Table>
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Die Bewegungsdaten beschreiben die Verknipfungen zu den
Stammadaten Uber die Angabe der FremdschllUsselbeziehung:

<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<Description>Bestellungen-Bewegungsdaten</Description>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>

<Name>Kunden-Code</Name>

<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>

<Format>YYYYMMDD</Format>

</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>

<Format>YYYYMMDD</Format>

</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>

<Format>YYYYMMDD</Format>

</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<I-- weitere columns... -->
<ForeignKey>

<Name>Kunden-Code</Name>
<References>Kunden</References>

</ForeignKey>
<ForeignKey>
<Name>Artikel-Nr</Name>

<References>Artikel</References>

</ForeignKey>
</VariableLength>
</Table>

Hinweis: Wahrend die Beschreibung eines VariablePrimaryKey die
Spalte vollstandig beschreibt, definiert ForeignKey keine neue Spalte.
Die im ForeignKey benutzte Spalte muss vorher bereits als
VariableColumn oder FixedColumn definiert worden sein.
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Beispiel 3 fiir eine INDEX.XML (komprimierte Daten)

Index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.2</Version>
<DataSupplier>
<Name>Audicon GmbH</Name>
<Location>Germany</Location>
<Comment>A compressed sample DataSet</Comment>
</DataSupplier>
<Command>uncompress.bat</Command>
<Media>
<Name>Disk 1</Name>
<Table>
<URL>dummy.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>dummy</Name>
<Numeric/>
</VariablePrimaryKey>
</VariableLength>
</Table>
</Media>
</DataSet>

uncompress.bat

rem
rem uncompress.bat

rem expandiert gdpdu.zip in das windows-temp-verzeichnis, unterverzeichnis gdpdu
rem
mkdir %temp%\gdpdu

pkunzip gdpdu.zip %temp%\gdpdu

%temp% ist eine Betriebssystem-Umgebungsvariable, die den Pfad
zum Temporar-Verzeichnis reprasentiert.

Die Datei gdpdu.zip enthadlt die gepackte Datentragerbereitstellung
(einschlieBlich INDEX.XML und GDPDU-01-08-2002.DTD). Der Prufer
offnet nach dem Dekomprimieren also die neue Datenbereitstellung in
dem Verzeichnis %TEMP%\gdpdu.

Hinweis: Die <Version>-Angabe bezieht sich nicht auf die Version des
Beschreibungsstandards sondern auf die Version der Datentrager-
Uberlassung.
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Haufig gestellte Fragen

midssen wir die Daten im XML-Format liefern?

Nein! Nur die Beschreibung der Daten (INDEX.XML) ist im XML-
Format. Die Nutzdaten sind im FixedLength oder VariableLength
Format.

kann Ihr System mit Daten in DOS/Unix/Mac-Formaten
(Zeilentrenner) umgehen?
Ja, denn die Zeilentrenner kdnnen explizit angegeben werden.

Wie sind negative Zahlen darzustellen (vor/hinter der Zahl,
Leerzeichen zwischen Vorzeichen und Zahl erlaubt)?

Negativen Zahlen ist ein Minuszeichen ohne Leerstelle vor- oder
nachzustellen

(z.B. ,-1782,90" oder ,,1782,90-").

Wenn eine Uberlassene Datei zu groB fur einen Datentrdger ist,
kann sie dann auf mehrere Datentréager gesplittet werden?

Der Beschreibungsstandard sieht ein Splitten einer Datei nicht vor.
In diesem Fall kénnen Sie aber die Daten komprimieren oder ein
Speichermedium mit gréBerer Kapazitat (z.B. DVD) wahlen.

Welchen XML-Parser verwenden Sie?
Wir verwenden Xerces (http://xml.apache.org/xerces-c/index.html).

Ist es ein Fehler, wenn ForeignKey eine Tabelle referenziert, die
nicht im DataSet enthalten ist, oder wiirde der ForeignKey dann
ignoriert werden?

Die Beschreibung der Verlinkungen muss mit den gelieferten Daten
ubereinstimmen, andernfalls ist Ihre Datentrageriberlassung nicht
konsistent.

Der Import-Prozess weist den Prifer auf die Inkonsistenz hin.

Was passiert, wenn in der index.xml eine Tabelle beschrieben wird,
die aber anschlieBend nicht vorhanden ist?

Die Beschreibung der Dateien muss mit den gelieferten Dateien
ubereinstimmen, andernfalls ist Ihre Datentrageriberlassung nicht
konsistent.

Der Import-Prozess weist den Prufer auf die Inkonsistenz hin.
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Sind Commands zwingend erforderlich? Stellen Sie fir Commands
Umgebungsvariablen zur Verfliigung?

Commands sind nicht zwingend erforderlich. Wenn eine .BAT oder
.CMD Datei aufgerufen wird, stehen die Ublichen Betriebssystem-
Umgebungsvariablen zur Verfliigung. Der Import-Prozess setzt selbst
keine Umgebungsvariablen.

Wie kann abschlieBend gepriift werden, ob die Daten des
Datentrégers von Ihrem System eingelesen werden kann?

Die sichere Variante der Prifung ist der Import mit IDEA fur GDPdU
(IDEA 2002 + SmartX).

Audicon plant ein SDK (Software Development Kit), das u.a. eine
Verifizierungs-Moglichkeiten zur Verfligung stellt.

Eine einfache Mdglichkeit, die XML-Datei auf ihre syntaktische
Korrektheit zu testen, ist, sie mit einem XML-fahigen Browser zu
offnen (z.B. dem Microsoft Internet Explorer ab Version 5.5).

Da ich mit XML-Standards nicht vertraut bin, ist mir nicht klar, wie
ich die Dateien: INDEX.XML und GDPDU.DTD konkret aufzubauen
habe. Ich habe Ihnen eine VariableLength-Datei zugeschickt,
kénnen Sie mir die korrespondierende XML- bzw. DTD-Datei
erstellen?

Sie sollten sich Grundkenntnisse in XML aneignen, die DTD-Datei
mussen (durfen!) Sie nicht modifizieren.

Die Beschreibung der Daten (also die INDEX.XML) sollte immer von
der Stelle aus geschehen, die die Datenhoheit besitzt, also vom
Softwarehersteller oder dem steuerpflichtigen Unternehmen.

Eine Informationsquelle sind die GDPdU-Seminare von Audicon, die
auch auf die technischen Details eingehen (siehe www.GDPdU.com).

In einigen Pressemitteilungen werden auBer VariableLength und
FixedLength noch zahlreiche weitere Dateiformate genannt. Welche
Formate sind fir die Datentrdgeriberlassung relevant?

Die in einigen Artikeln genannten Dateiformate beziehen sich auf die
originaren Import-Méglichkeiten der Software IDEA.

Der Beschreibungsstandard ist aber produktunabhangig und
unterstitzt in der aktuellen Version nur die beiden allgemeingultigen
Formate VariableLength und FixedLength.
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Muss die GDPDU-01-08-2002.DTD mit auf die CD-ROM gebrannt
werden?

Ja. Eine CD-ROM, die zur Datentrageruberlassung dient, muss die
GDPDU-01-08-0220.DTD, die INDEX.XML und alle Nutzdaten (z.B.
T1.CSV, T2.CSV, T3.CSV, T4.ASC) enthalten.

In einer VariableLength-Datei sind im ersten Datensatz die
Feldnamen gespeichert. Wie kann man den ersten Satz (iberlesen?
Verwenden Sie die Range-Angabe im Table-Element:

<Table>
<Range>
<From>2</From>
</Range>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>

Wird durch die Angabe eines Zeichensatzes, z.B. UTF7 oder
Macintosh, die Angabe des Zeilenbegrenzers automatisch
Ubersteuert?

Nein! Nur die explizite Angabe des Zeilenbegrenzers
(RecordDelimiter) Ubersteuert den Vorgabewert (CRLF).
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